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Welcome Graphics, Art, Media, Entertainment Recruit (G.A.M.E.R.) 

 
 

The BrainBuffet Graphics, Art, Media, Entertainment (GAME) experiment mission handbooks are designed for use with the BrainBuffet 

video-based online courses. Graphics, Art, Media, Entertainment Recruits (GAMERs) are expected to be familiar with all resources and 
content within this workbook and the associated video curriculum to graduate the program. All GAMERs should have a blast learning cool 

stuff, create awesome images, and share their creations as frequently possible on social media, and tag us @brainbuffet to show us the 
amazing graphics you create!  

 
Everything we do @BrainBuffet is #ForTheKids and #CertifiablyCreative! 

 
ACATestPrep is a division of BrainBuffet.com and is available through the GMETRIX platform.  

 This workbook can be used and shared in its entirety as long as the footer and BrainBuffet branding is intact so people can f ind our video 
curriculum for the Adobe Certified Associate exams. Find out more about our best-selling curriculum created by award winning teachers 

at BrainBuffet.com.  
 

©2020 BrainBuffet 
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Photoshop Project 1 S.E.T. 

 
cenario: Personal photos for your social media timeline 
or travel photos often need a little tweaking to get 

that feeling that you experienced while you were 
there. We start with an introduction to the Photoshop 
Interface and critical settings, and then move on to 
cropping images, removing distracting elements, 
perfecting colors, and importing and exporting common 

file types from Photoshop. 
 

xpectations: Fix common problems in Photos.  
 
 

imeline: This should take you 5-6 hours of class time to 

complete. 
 

Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress Learning, Activity, Timestamp, Experience.) 

Day 1 Date: Day 2 Date: 

 
Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 

 
 
 
 
 

 
Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 

 
 
 
 
 
 

 
 
 
 
 
 

 

 

S 

E 
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Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress, Learning, Activity, Timestamp, Experience.) 

Day 3 Date: Day 4 Date: 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 
 
 
 

 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 

Day 5 Date: Day 6 Date: 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
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Photoshop Project 1 Worksheets 

Concise Help, Explanation, and Tips (CHEaTs) 

● Make sure you understand the workspace and how to customize it for your own personal 

workflow. 
● Some tools are hidden in the toolbar. Learn where they all live! 
● Understand how to work with RAW images 

● Learn to browse with Bridge, it’s an incredible tool 

 

NOTES: Using the BrainBuffet Project 1 tutorials, please answer the following questions.  

 
 

1. Label the diagram above with the name of each feature in the Photoshop 
Workspace, and a description of what it does. (1.01 - 1.03) 

 

 Name Description 

A.   

B.   

C.   

D.   

E.   

F.   
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2. What is the shortcut for Edit>Preferences>General? (1.01)  _________________________ 

 

3. What can you do in the Interface preferences? (1.01)   ____________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

4. In the File Handling preferences, what interval should you do automatic save 

recovery? (1.01)   ________________________________________________________________ 

5. What four file types can you export your work into when using the Quick Export format 

preferences? (1.01)  _____________________________________________________________ 

6. What do PNG files offer that JPG files do not? (1.01)  ______________________________ 

7. What adds the Copyright and Contact info to a project? (1.01)   __________________ 

_________________________________________________________________________________ 

8. What is recommended if you experience weird crashes or strange visuals for the video 

card in Photoshop? (1.01)  _______________________________________________________ 

9. Print resolution is best at (1.01) ____________________________ dpi.  

10. What is in the learn panel? (1.02)  ________________________________________________ 

_________________________________________________________________________________ 

11. As a designer or in the real world, we work ________________________________________ 

and not by  _______________________________________________________________ (1.02). 

12. If you only enter the values a tutorial shows you, you won’t learn ___________to use the 

software. Learn HOW to use the tools and adjust the image________________________ 

so that you can create unique and creative designs for a _____________________(1.02) 
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13. A _______________________________________ indicates where the panel will be placed 

when moving it around. A ________________________________________________________ 

indicates which panel group the panel group will be joining. (1.03) 

14. Double click on the ___________________________________ to zoom to 100%.  

Double click the ___________________________________________ to fit it the document to 

the window. (1.05, 1.11) 

15. What do you need to do to temporarily switch to the hand tool to “drag” your image 

around within the document window? (1.05, 1.11)  ________________________________ 

_________________________________________________________________________________ 

_________________________________________________________________________________ 

16. What keys on the keyboard changes the brush size? (1.06)  ________________________ 

_________________________________________________________________________________ 

 _________________________________________________________________________________ 

17. Describe how the clone stamp works. (1.06) ______________________________________ 

_________________________________________________________________________________ 

 _________________________________________________________________________________ 

 
18. What is the difference between destructive and non-destructive editing? Can you 

give examples? (1.07) ___________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

19. Look at __________________________________________________________ when adjusting.  

It’s easy to focus on just  _________________________________________________________ 

and miss  __________________________________________________________________  (1.07) 
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20. How do you “turn off” the adjustment layer? (1.07)  _______________________________ 

_________________________________________________________________________________ 

21. Opacity is  _____________________________________________________________________ .  

Opacity is the opposite of  ______________________________________________________ ,  

so 0 opacity is ____________________________________________________% transparency.  

22. What is the default file for a Quick Export? (1.08)  __________________________________

_________________________________________________________________________________  

23. Change metadata to  ___________________________________________________________

_ as a default for your exported files. This will include any copyright and contact info 

you’ve included, and if there is no info it will just be empty. (1.08) 

24. It’s best practice to check what option when saving for the web for consistent color? 

(1.08)  ___________________________________________________________________________ 

_________________________________________________________________________________ 

25. What Metadata gets recorded when a picture is taken with most smart phones? 

(1.09)  ___________________________________________________________________________ 

26. If a preview doesn’t show in your finder, how should you view your photos and see the 

Metadata? (1.09)  _______________________________________________________________ 

27. What are RAW files? (1.10) _______________________________________________________ 

_________________________________________________________________________________ 

28. What images are best to get from the client?  (1.10) _______________________________ 

29. What option allows you to fill a selection using the surround pixels in an image? (1.10)

_________________________________________________________________________________ 

30. What is the shortcut to remove “marching ants”? (1.11) ___________________________ 
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Photoshop Project 1 Checklist and Rubric 

PROJECT 1 SPECIFICATIONS 

Red Fort Photo PSD: 
 

 Be straightened. 

 People removed with spot 

healing brush. 

 Metadata has Copyright & 
Contact Info 

 

PSD Layers: 

 Modified 
Brightness/Contrast 
Adjustment Layer 

 Modified Hue/Saturation 

Adjustment Layer 

 

Northern Lights Photo 
 

 Horizon straightened 

 People have been 

removed using content 
aware fill 

 

Completed folder should have: 

 Aurora PNG 

 RedFort PNG 

 RedFort PSD 

 RedFort@0,1x 

 RedFort@0,25x 

 

You should be able to: 

 

 Save or reset 
workspace 

 Change the metadata 
and add keywords 

 Open an image in 
Photoshop 

 Save an image as a 
Photoshop Document 
(PSD)  

 Quick export an image 

 Adjust width of panel, 
move panels around 
within workspace 

 

 
 

PHOTOSHOP PROJECT 1 SCORING RUBRIC Score 

Mastery of 

Skills 

10 points: 
Student is able to demonstrate 
abilities according to 
specifications. (Screenshots of 
progress recommended or 
extra images have been 
completed to show mastery in 
skills). 

7 points: 
Only the required images 
are completed without 
screenshots or extra 
images to demonstrate a 
mastery of skills 
according to specs. 

1 point: 
For each 
image 
completed, 
add a single 
point.  

 

Effort Level 10 points: 
Photographs are carefully 
corrected as shown in the 
tutorials. Finished images have 
natural looking colors and 
retouching is invisible. 

7 points: 
Tutorial instructions have 
been followed, but 
finished images have 
noticeable retouching or 
unnatural looking colors. 

4 points: 
Tutorial 
instructions 
were not 
followed 
completely. 

 

Requirements 

Completed 

5 points: 
Files are properly saved in 
multiple formats for web and 

digital storage. 

2 points: 
Files are saved only as one format or 
saved incorrectly. 

 

 

Total Points Earned  

(25 points possible) 
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Photoshop Project 1 Extension Projects 

 

Project 1 Extension Challenges: 

● Complete BrainBuffet Photoshop CC15 Project 1 “Facebook Tweaks” 

● Restore some of the extra images in the downloads folder for this project. 

● Try a Photoshop tutorial you find online  

● Find photos online and fix them yourself 

● Adobe Education Exchange- Especially  Photoshop Retouching Tutorials 

 

Project 1 Cross-Curricular Enrichment: 

● Language Arts: Complete an interview with a family member about a trip they took 

that changed their perspective on life. Write a report on the lives of the people in your 
pictures and the events shown. 

● Language Arts: Compose a fictional account of the people in your pictures and the 
events shown. 

● Math- Write a formula that calculates final image size based on pixel size and 

resolution 

● Social Studies- Find an image from a famous historical event and restore it, then write 
a brief reflection on the importance of that event.   

● Science/Technology- Research how images are created or shared- there are many 
ways!! Printing, Film, Digital cameras, projection (digital and film,) 

● Science/Technology- Make your own film camera. Yes, seriously- it’s not that hard! 
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Photoshop Project 2 S.E.T. 
cenario: People hire photographers for many different 
occasions such weddings, engagement sessions, press 

conferences, band performances. In this project, 
students will learn ways to modify photos in a professional 
style. 
 

xpectation: Learn how to import photos and enhance 

photos to look more professionally done. 
 

imeline: This may take a student 5-6 hours of class time to 
complete. 
 

Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress Learning, Activity, Timestamp, Experience.) 

Day 1 Date: Day 2 Date: 

 
Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 

 
 
 
 

 
Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 

 
 
 

 
 
 
 
 

 
 
 
 

 

 

S 

E 

T 
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Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress, Learning, Activity, Timestamp, Experience.) 

Day 3 Date: Day 4 Date: 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 
 
 
 

 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 

Day 5 Date: Day 6 Date: 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
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Photoshop Project 2 Worksheets 
 

Concise Help, Explanation, and Tips (CHEaTs) 

● Understand how to work with RAW images 

● Be careful when using the clone stamp and content aware fill! Photoshop is an amazing tool 
but it takes the designer to make image retouches appear natural! 

● Be careful when you’re destructively editing a photo! It changes the composition of an image 
so be sure to save a copy of the original in case you need to start over. 

● Know how to work with smart objects and why they’re important 

 

NOTES: Using the BrainBuffet Project 2 tutorials, please answer the following questions.  

 

1. Label the Photoshop tools below and give a description of what it does. (2.02, 2.05) 

 

 

 Video Name Description 

 

2.02   

 

2.02   

 
2.02   

 

2.02   

 

2.05   

 

2.05   

 

2.05   

 

2.05   
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2. When using the healing brush,  ___________________________________________________  

to avoid visibly repeating patterns. Be sure to resample from _______________________

______________________________________________________ to mix up the pattern. (2.02) 

3. Turning the _______________________________________ of a brush down makes the edges 

fade away from the center, giving a gradual effect. (2.03) 

4. On layer masks, _______________________________________ hides that part of the layer and 

_______________________________________ reveals that part of the layer. (2.03) 

5. What keyboard shortcut swaps the foreground and background colors? (2.03) X 

6. When Photoshop doesn’t seem to be doing what you expect always  _____________ 

__________________________________; whichever  ___________________________________ 

__________________________________ will be affected by the changes you make. (2.03) 

7. What should be checked when saving a PSD? (2.03)  _____________________________ 

  ________________________________________________________________________________ 

_________________________________________________________________________________ 

8. Raw images can’t be ________________________________. They are the 

_______________________________________ straight from the camera’s sensor.  

They include _____________________________________________ the sensor “sees” even it 

won’t be visible to _______________________________________________________. (2.04) 

9. RAW image settings are saved in a(n) _____________________________________________ 

when you edit in Adobe Camera RAW. (2.04) 

10. What must you do with the XMP file after editing the RAW image in Photoshop? (2.04)

__________________________________________________________________________________ 

________________________________________________________________________________ . 
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11. You can duplicate a layer by ____________________________________________________ 

_______________________________________________________ in the Layers panel (2.05) 

12. How do you convert a layer to a smart object? (2.05) _____________________________

________________________________________________________________________________ . 

13. Smart objects _______________________________________  the pixels so 

_______________________________________  can be destroyed. Smart objects are special 

layers in Photoshop that are _______________________________________. What does this 

mean? (2.05) ____________________________________________________________________

___________________________________________________________________________________ 

14. The “tic-tac-toe” board is called the _______________________________________. For a 

visually pleasing layout, ___________________________________________________________, 

__________________________________________________favoring the intersections. (2.06) 

15. Try to create a pretty safe and slightly _______________________________________ image 

in RAW to bring into Photoshop. This way, you can _________________________________ 

__________________  in Photoshop later without _____________________________________ 

_______________________________________ the RAW image. (2.08) 

16. How do you non-destructively crop your images? (2.08) ____________________________ 

___________________________________________________________________________________

Why is this important?  ___________________________________________________________ 

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

17. What is recommended to have more control of your brush? (2.08) _________________  

________________________________________________________________________________ 
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18. What filter was recommended on the street photo? (2.09)  ________________________ 

_________________________________________________________________________________ 

19. Saturate _______________________________________________  color, and  

desaturate _____________________________________________ color. (2.09) 

20. What does it mean to modify an image visually and not specific numbers? Why is this 

important in photography/graphic design?  ______________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 
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Photoshop Project 2 Checklist and Rubric 

PROJECT 2 SPECIFICATIONS 

Krysti PSD  

 

 Blemishes removed on face of model 
 
PSD Layers: 

 Brightness/Contrast Layer 1 

 Brightness/Contrast Layer 2 with modified 
mask and opacity lower than 100% 

 Background Layer 

 

Engagement Photo PSD  
 

 Hair removed on female with healing 
brush 

 Iris has been sharpened 

 Clasp removed from necklace 

 Image cropped with bride in the middle 

and groom off-center 
 
PSD Layers: 

 Brightness/Contrast Layer 1 with modified 
layer mask  

 Background Copy 

 Layer 0 [smart object] 

 

GHJohn PSD  

 

 Remove signs with content aware fill 

 Remove pole on left 

 Remove distractions on right 

 
PSD Layers: 

 Brightness/Contrast Layer 1 with modified 

mask and opacity lower than 100% 

 Vibrance Layer 1 

 Background Layer 

 

DSBguitar PSD 
 

 Cropped without deleting pixels 
 
PSD Layers: 

 Should be at least 3 adjustment layers in 

the PSD 

 

IndianGirl.png 

 

 Fix blemishes 

 Dodge for eyes 

 Sponge tool on lips 

 Cropped with pixels & straightened 

 
 

FaceSwap PSD  
 

 Remove snowflake from Rob’s face 

 Spot healing, remove peeps 

 
PSD Layers: 

 Hue/Saturation Layer 1  

 Levels Layer 1 

 Background Layer 

 

 

Completed folder should have: 

 

 Original Raw Images & XMP files 

 DSBGuitar PSD 

 DSB Guitar PNG 

 Engagement Photo PSD 

 Engagement Photo PNG 

 FaceSwap PSD 

 Face Swap PNG 

 GHJohn PSD 

 GHJohn@0,3x PNG 

 IndianGirl PNG 

 Krysti PSD 

 Krysti PNG 

 
You should be able to: 

 

 Use spot healing brush 

 Use dodge tool 

 Use clone stamp 

 Crop an image 

 Export an image including metadata and sRGB 
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Photoshop Project 2 Rubric 

Project 2 Extension Challenges: 

● Complete BrainBuffet Photoshop CC15 Project 2 - Restoring Old Photos 

● Retouch some of the extra images in the downloads folder for this project. 

● Try a Photoshop tutorial you find online  

● Find photos online and fix them yourself  

Project 2 Cross-Curricular Enrichment: 

● Language Arts: Take a nature shot and use Photoshop to enhance the photo. Write lyrics or a poem 

inspired by the photo. Create a Photoshop document featuring your poem. 

● Language Arts: Compose a fictional account of the people in your pictures. 

● Math- Do some research on how much an engagement or wedding photographer costs. Figure out 

how many photoshoots a photographer needs to complete to make a $40,000/yr salary. Report your 
findings.  

● Social Studies- Do some research on the first cameras and how they were used. How are they different 

from what we use today?   

● Science/Technology- Research the process of developing film (yes, film). Also, research darkrooms and 

how to make your own at home. What do you have to do and what do you need? Report your 
findings (and use something other than WikiHow). 

  

PHOTOSHOP PROJECT 2 SCORING RUBRIC Student 

Score 

Mastery of 

Skills 

10 points: 
Student is able to 
demonstrate abilities 
according to specifications. 
(Screenshots of progress 
recommended or extra 
images have been 
completed to show mastery 
in skills). 

7 points: 
Only the required 
images are completed 
without screenshots or 
extra images to 
demonstrate a mastery 
of skills according to 
specs. 

4 points: 
Not all images are 
completed.  

 

Effort Level 10 points: 
Photographs are carefully 
corrected as shown in the 
tutorials. Finished images 

have natural looking colors 
and retouching is invisible. 

7 points: 
Tutorial instructions 
have been followed, 
but finished images 

have noticeable 
retouching or unnatural 
looking colors. 

4 points: 
Tutorial 
instructions were 
not followed 

completely. 

 

Requirements 

Completed 

5 points: 
Files are properly saved in multiple 
formats for web and digital storage. 

2 points: 
Files are missing or saved 
incorrectly. 
 

 

Total Points Earned  

(25 points possible) 
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Photoshop Project 3 S.E.T. 
cenario: Photoshop can do more than just 
photography- it’s a full-fledged design tool! 

This project will introduce you to some critical 
concepts for print design and you’ll create a 
magazine cover that represents your life and 
interests. Make it personal and have a blast 
designing for print in Photoshop! 

 

xpectation: Learn how to create a 
professional looking magazine cover using 
type & images. 

 

imeline: This should take you 5-7 hours of class time to complete. 

 
 

Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress Learning, Activity, Timestamp, Experience.) 

Day 1 Date: Day 2 Date: 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 
 
 

 
 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 

 
 
 
 

 
 
 
 
 

 

 

S 

E 
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Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress, Learning, Activity, Timestamp, Experience.) 

Day 3 Date: Day 4 Date: 

 
Videos Completed: _______________________ 

 

Screenshots to document progress?    

 

What was the coolest thing you learned? 
 
 
 
 
 

 
Videos Completed: _______________________ 

 

Screenshots to document progress?    

 

What was the coolest thing you learned? 
 

Day 5 Date: Day 6 Date: 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 

 
 



 
 
Name: ________________________________________________________   Date: _____________ Period: _________ 

 

ACATP ON GMETRIX | PHOTOSHOP CC18|19|20 | GAMER MISSION HANDBOOK 
 

                                                                      Freely use and copy this unmodified workbook with this footer intact.  

 Page 26 

Day 7 Date: Day 8 Date: 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 

 

Concise Help, Explanation, and Tips (CHEaTs) 

● Remember that when a layer is locked, you may not be able to edit it! Look for the 

lock symbol. 
● Know the difference between a type layer and a rasterized layer. Sometimes students 

accidently rasterize a type layer and then it is no longer editable. 
● Be careful not to merge your layers. You need the layers in order to edit your 

Photoshop document correctly. 
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Photoshop Project 3 Worksheets 
 

NOTES: Using the BrainBuffet Project 3 tutorials, please answer the following questions.  

 
1. To open a new document, go to  ________________________________________________ 

or press __________________________________________________ on the keyboard. (3.01) 

2. What are the print presets on Photoshop CC18|19|20? (3.01)  _____________________ 

  ________________________________________________________________________________ 

  ________________________________________________________________________________ 

3. What are the screen presets on Photoshop CC18|19|20? (3.01)  ___________________ 

  ________________________________________________________________________________ 

  ________________________________________________________________________________ 

4. What is web resolution? (3.01) ____________________________________________________ 

  ________________________________________________________________________________ 

5. What is print resolution? (3.01)  ___________________________________________________

_________________________________________________________________________________ 

6. What is bleed space? (3.01)  _____________________________________________________ 

  ________________________________________________________________________________ 

7. It is best to set up your document in ______________________________________ because 

that’s Photoshop’s ______________________________________. (3.01) 

8. What two ways can you show rulers in your Photoshop workspace? (3.02)  _________

_________________________________________________________________________________ 

9. How can you change the ruler measurement? (3.02)  _____________________________

_________________________________________________________________________________ 

  ________________________________________________________________________________ 
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10. How do you show the grid on your canvas? (3.02) _________________________________

_________________________________________________________________________________ 

11. What are guides? (3.02) _________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

12. What are two ways to add guides to your canvas? (3.02) __________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

13. Going to Image>Canvas Size ______________________________________. It modifies 

Photoshop document size without  ______________________________________________ . 

The relative box ______________________________ or ___________________________ the 

values you enter from the current __________________________. If you use a 

________________________ to ____________________________ one or two sides of your 

document, they ____________________ _____________________________. The document 

will only grow in the ___________________ of the arrows. (3.02) 

14. How do you move guides around? (3.03)  ________________________________________ 

  _______________________________________________________________________________ .  

15. How do you lock guides? (3.03 ___________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

16. Saving a file _____________________________________________ and you continue working 

in the document. Saving a copy __________________________________________________ 

and you continue working in the original document. (3.03) 
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Fill in the blanks as you watch 10 Creativity Tips (3.04) 

 

17. Creative Strategy 1: Find ____________________________________________, colors, 

_________________________________, ideas, etc. that you need to include in your 

design. This gives you a _______________________________________ to create from. 

18. Creative Strategy 2: Make it __________________________. When learning/practicing, 

always try to __________________________ into something you like. It’s more 

__________________________ to do a project you’re excited about than 

__________________________ some stranger’s example. 

19. Creative Strategy 3: __________________________, don’t brain drizzle. Generate a lot of 

___________________, even bad ones. If you try to only think of great ideas, you 

__________________________. Eliminate the fear of bad ideas and you’ll get great ones. 

20. Creative Strategy 4: Make every project __________________________, even if it’s you. 

Learn the process of creating a design that wraps around __________________________, 

not just your own __________________________. 

21. Creative Strategy 5:Extend the idea to __________________________. Don’t focus just on 

the __________________________ but the _______________________. Don’t sell the drill, sell 

the hole in the wall. Don’t sell the camera, sell the memories you can capture with it. 

22. Creative Strategy 6:__________________________, even if you stink at drawing. It lets you 

see __________________________ and __________________________ before you’ve 

invested much time and effort. 
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23. Creative Strategy 7: Steal cool __________________________. Integrate them into your 

own designs. A(n) __________________________ can’t be stolen, plagiarism is 

_______________________________. The ________________________________________ and 

_____________________________________ are up for grabs. 

24. Creative Strategy 8: ______  Get ______________________________. Search for and pay 

attention to _______________________________________________________. If it captures 

_______________________________________ - try to figure out why and use that trick. 

25. Creative Strategy 9: _ ______________________Do the ______________________________. 

Don’t ____________________________________ that the pros use. Nobody wants to 

________________________________________. If the pros tell you to do it… do it.  

(all the pros say to _______________________________________ first) 

26. Creative Strategy 10: _____________________________ Take __________________________. 

Playing it __________________________ is playing to __________________________________. 

Don’t be a dummy, but don’t be a chicken either. 

27. Embedded images ______________________________________________________________ 

_______________________. This image _________________________ be updated if the 

original changes. (3.05) 

28. Linked images ____________________________________________________________________ 

_______________________. This image ______________________________ be updated if the 

original changes. (3.05) 

29. Going to __________________________ affects the active layer and going to 

__________________________ affects the entire document (3.05) 
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Define the typography terms below (3.06) 

30. Kerning  

31. Tracking  

32. Leading  

33. Serif fonts  

34. Baseline  

 

35. Where is kerning generally used? (3.06) ___________________________________________

_________________________________________________________________________________ 

36. What can do to a title can help give it a more important, powerful feel? ___________

_________________________________________________________________________________ 

37. What is recommend before rasterizing a type layer? (3.09)_________________________

_________________________________________________________________________________ 

38. How do you invert a layer mask? (3.11) ___________________________________________

_________________________________________________________________________________ 

39. How do you rasterize a layer? (3.12) ______________________________________________

_________________________________________________________________________________ 

40. What do you press on the keyboard to select multiple layers? (3.13)  _______________

_________________________________________________________________________________ 

41. With the text tool active, _____________________________________ to select a word. 

________________________________________ to select a line. (3.15) 
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42. Label the Photoshop icons below and give a description of what it does. (3.16) 

 

 

 

 

 

 

43. How do you make sure your print document is going to print at 100%? (3.18)________

_________________________________________________________________________________ 

44. How do you save a JPG file? (3.18) _______________________________________________

_________________________________________________________________________________ 

45. Click on __________________________ when saving for print. (3.18) 

Label Description 

A 

 
 

B 

 
 

C 

 
 

D 

 
 

E 

 
 

F 
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46. How do you view what your document will look like before offset printing? (3.19) ___

_________________________________________________________________________________ 

47. What is soft proofing? (3.19) ______________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

48. How do you convert your image from RGB to CYMK? (3.19) _______________________

_________________________________________________________________________________

_________________________________________________________________________________ 
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Photoshop Project 3 Checklist 

PROJECT 3 SPECIFICATIONS 

LastName Mag PSD (8.25in x 10.25in) 

 
Document set up with guides 
 
PSD Layers: 

White Group  

 Articles White Group (locked): 

• Rob Schwartz type layer with Outer Glow 

layer style with character changes 
(locked) 

• Overcoming Fear Type Layer with 
character adjustments (locked) 

• Failure is the Path Type Layer with 

character adjustments (locked) 

 CrashRob Group (locked): 

• “I” Type Layer (locked) 

• Shattered layer with modified layer mask 
(locked) 

• Trampshot layer [smart object] with 

modified layer mask (locked) 

• Rasterized Leap layer with modified layer 
mask (locked) 

• White color fill layer (locked) 

 

Black Group 

 Articles Black Group (locked): 

• Rob Schwartz type layer with Outer Glow 

layer style with character changes 
(locked) 

• Overcoming Fear Type Layer with 
character adjustments (locked) 

• Failure is the Path Type Layer with 

character adjustments (locked) 

 Closeup Black Group (locked): 

• “T” layer with modified layer mask and 

Drop Shadow layer style (locked) 

• Black & White adjustment layer (locked) 

• Trampshots layer [smart object] (locked) 

• Black color fill layer (locked) 

Completed folder should have: 

 Black Mag Group: 

• LastNameMag JPG 

• LastNameMag@0,5x JPG 

• LastNameMag@2x JPG 

 LastNameMag JPG [white] 

 LastName Mag PSD 

 LastNameMag@0,5x JPG [white] 

 LastNameMag@2x JPG [white] 

 LastNameMagBlack PSD 

 LastNameMagWhite PSD 

 LastNameTEMPLATE PSD 

 

You should be able to: 

 

 Add a guide to the canvas 

 Group layers 

 Lock layers 

 Change the unit of measurement on rules 

 Add color fill layer 

 Modify tracking and kerning on a type 
layer 

 Add and modify layer masks 

 Open document, then be able to change 
height, width, measurement, orientation, 
resolution, and color mode and save preset 
settings 

 Save a document as a copy 

 Apply and save layer styles 
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Photoshop Project 3 Rubric 

Project 3 Extension Challenges: 

• Complete BrainBuffet Photoshop CC15 Project 3 - Awesome Event Announcement  

• Complete BrainBuffet Photoshop CC15 Project 4 - Hogwartz Pet Store 

• Design another cover with the extra images in the Enrichment Folder 

• Try a Photoshop tutorial you find online  

• Check out some other Magazine tutorials 

• Adobe Education Exchange- Especially Typography Tutorials 

Project 3 Cross-Curricular Enrichment: 

● Language Arts: Write an article for your magazine! 

● Math- Get a magazine and count the number of advertisements in it. Then research how much 
companies pay for magazine ads (remember, there are full page or half page or ¼ page ads). 
Show how much the Magazine made. 

● Social Studies- As a nod to the wild west, create some “vintage” ads. Then research how to 
“coffee stain” paper to make it look old. 

● Science/Technology- Look up how to do screen printing (without having to buy fancy equipment) 
and try to make a T-shirt using Photoshop and the tutorials you find! 

PHOTOSHOP PROJECT 3 SCORING RUBRIC Student 

Score 

Mastery of 
Skills 

10 points: 
Student is able to 
demonstrate abilities 
according to specifications. 
(Screenshots of progress 
recommended or extra 
images have been 
completed to show mastery 
in skills). 

7 points: 
Only the required 
images are completed 
without screenshots or 
extra images to 
demonstrate a mastery 
of skills according to 
specs. 

4 points: 
Image is turned in.  

 

Effort Level 10 points: 
Magazine covers are 
created as shown in the 
tutorials. Images look 
aesthetically appealing 
and professionally done.  

7 points: 
Tutorial instructions 
have been followed. 
Images are not as 
clean and professional 
as they could be. 
Improvements could 
be made. 

4 points: 
Tutorial instructions 
were not followed 
completely. 

 

Requirements 

Completed 

5 points: 
Files are properly saved in multiple 
formats as shown in the tutorials. 

2 points: 
Files are saved only as one format or 
saved incorrectly. 

 

Total Points Earned  

(25 points possible) 
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Photoshop Project 4 S.E.T. 
cenario: Photoshop is more than a 
Photo editor, it’s the most popular 

and powerful design tool on the 
planet. Use this tutorial to learn to 
create a CD Sleeve that hints at your 
interests and style with some cool 
effects and tricks of the Trade! 

 

xpectations: Learn how to create 
a professional CD cover using 
type, vector shapes & images. 

 

imeline: This mission may take a student 4-6 hours of class time to complete. 

 
 

Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress Learning, Activity, Timestamp, Experience.) 

Day 1 Date: Day 2 Date: 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 
 
 

 
 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 

 
 
 
 

 
 
 
 
 

 

 

S 
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Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress, Learning, Activity, Timestamp, Experience.) 

Day 3 Date: Day 4 Date: 

 
Videos Completed: _______________________ 

 

Screenshots to document progress?    

 

What was the coolest thing you learned? 
 
 
 
 
 

 
Videos Completed: _______________________ 

 

Screenshots to document progress?    

 

What was the coolest thing you learned? 
 

Day 5 Date: Day 6 Date: 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
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 Concise Help, Explanation, and Tips (CHEaTs) 

 

● Remember to organize your layers panel. When a project has multiple layers, it is easier 
to find the layers you need if you group and label. 

● Play with blending modes, opacity, and fill. You may get an even cooler effect than 
the tutorial! 

● Play with layer styles and modify them to your liking. Often the best results are from just 

playing with the software. 
 

For Photoshop CC19 or 2020 Users 
 
To follow along with 4.08 – Vector Shapes in 
Photoshop video, please follow the instructions 

below: 
 
Click on Window>Shapes, it will bring up the Shapes 
panel. Then, click on the panel menu where you’ll 
be able to select Legacy Shapes and More. (See 

photo 4.08a) 
 

 
 
 

 
Once you’ve added that folder, you  
should be able to see the legacy vector  
shapes in the custom shape option bar. 
(See photo 4.08b) 

 

 
 
 
 
 

 
 
 
You should also see the Grime custom 
shapes. (See photo 4.08c 

 

 

 

 

Photo 4.08a 

Photo 4.08b 

Photo 4.08c 
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Photoshop Project 4 Worksheets 
 

NOTES: Using the BrainBuffet Project 4 tutorials, please answer the following questions.  

 
1. Artboards operate like a ____________________________________________________. (4.01) 

2. _________________________________________________ attempts to automatically select 

the subject in an image. (4.02) 

3. When using Magic Wand tool hold __________________________ to add to a selection. 

___________ ____________________________________to subtract from a selection. (4.02) 

4. The tolerance is __________________________________________________________________. 

Adjust the tolerance to make the magic wand ______________________________. (4.02) 

5. To refine a selection, go to __________________________________________________. (4.02) 

6. How do you add a solid color layer? (4.02) _________________________________________ 

_________________________________________________________________________________ 

7. How do you duplicate a layer? (4.02)  ____________________________________________

_________________________________________________________________________________ 

8. ____________________________________________ need to be rasterized before you can 

destructively edit. (4.03) 

9. Being a good designer is more about learning ____________________________________ 

are than learning ____________________________________. Tools can be  _____________

___________________________________________________________ . Design skill and ideas 

__________________________________________________________________________ . (4.06) 

10. Define rasterize: (4.07 ____________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 
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11. Define Pixels: (4.07)  ______________________________________________________________

_________________________________________________________________________________ 

12. Define Raster (aka bitmap) Images (4.07)  ________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

13. Define Vector images: (4.07)  ____________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

14. What are 4 ways to rasterize a group, smart object or text? (4.07) 

a. _____________________________________________________________________________ 

b. _____________________________________________________________________________ 

c. _____________________________________________________________________________ 

d. _____________________________________________________________________________ 

15. How do you flip an object? (4.07)  ________________________________________________

_________________________________________________________________________________ 

16. _____________________________ is like flipping a page in a book. 

_____________________________ is flipping a page in a notepad or legal pad. (4.07) 

17. Define Layer opacity (4.09) ______________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

18. Define Layer fill (4.09) ____________________________________________________________

_________________________________________________________________________________  
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19. How do you add bleed to artboard? (4.11) _______________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

20. Define adjustment layers: (4.12) __________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

21. Define smart filters: (4.12)_________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

22. How do you save artboards? (4.12) _______________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

23. How do you save individual layers as files? (4.12) __________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 
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Photoshop Project 4 Checklist 

 PROJECT 4 SPECIFICATIONS 

CD Sleeve PSD 
 
PSD Layers: 

Back Group (Separate Artboard. 5.25in x 5.25in) 

 “Layer 2” (filled in selected with lowered 
opacity) 

 Rasterized Title layer with Color Overlay 

 Photo Filter Adjustment Layer clipped to 
image below it 

 Image smart object layer with Smart Filter 

applied 
 

Front Group (Separate Artboard, 5in x 5in) 

 Title Group: 

• Vector Shape 2 (line) 

• Vector Shape 1 (heart) 

• Rasterized Title layer 

 Figure Group 

• Gradient layer with modified layer mask. 

Opacity is lower than 100% 

• Guy Group 
o Rotated image with modified layer 

mask. Opacity lower than 100% 
o Black & White adjustment layer 
o Image of subject with surroundings 

erased 

 Background Group 

• Polygon vector shape (triangle) with 
outer glow layer style. Fill is 0% 

 Originals Group 

• Gradient layer with modified layer mask. 
Opacity is lower than 100% 

• Title Group 

o Resolute Evolution Type layer with 
kerning greater than 0 

o 3volut3 Type layer with kerning 
greater than 0 

o Smart object of subject’s original 
photo with layer mask hiding 
surroundings 

Completed folder should have: 

 CD Sleeve PSD file 

 CD-SleeveBack PNG file 

 CD-SleeveFront PNG file 

 

Student should be able to: 

 

 Add vector shape to document 

 Refine selection using Select>Select and 
Mask (know how to adjust opacity and use 
refine edge brush tool) 

 Change blending mode of a layer from 
normal (to screen, overlay, etc.) 

 Modify opacity or fil of a layer 

 Flip an image (not the canvas) vertically or 
horizontally 
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Photoshop Project 4 Rubric 

 

Extension Challenges: 

● Complete BrainBuffet Photoshop CC15 Project 5 - Mysterious Scene 

● Complete BrainBuffet Photoshop CC15  Project 6 - Bring It All Together 

● Design another cover with the extra images in the Enrichment Folder 

● Design a poster promoting the band on the CD 

● Adobe Education Exchange – look for Photoshop tutorials or Design inspiration 

Cross-Curricular Enrichment: 

● Language Arts – Most CDs have a brief biography of the musical artist. Write one for your CD cover. 

How did the musician(s) get started? What type of music is it?  

● Math- Research a concert/show/event in a city you would like to travel too (anywhere other than your 

hometown). Figure out how much it would cost to spend the weekend in that city and attend the 
concert or show. (Price out airline tickets or gas costs; a hotel; and don’t forget to factor in food!) How 

much would it set you back? How long would you have to save to make something like that happen 

for yourself? 

● Social Studies- Think of a famous poster from another time (look up “We Can Do It”). Try to renew the 

idea of that poster for your generation. Design it, draw it, photograph it… make it your own! Write a 
brief description on why you chose that poster and how you modernized it. 

● Science/Technology- CDs are almost a thing of the past (man… Rob is old!!) but even before CDs… 

there were these things called record players. There are tutorials on how to make one… go get a 
record and make (yes, make) a record player! 

PHOTOSHOP PROJECT 4 SCORING RUBRIC Student 

Score 

Mastery of 

Skills 

10 points: 

Student is able to 

demonstrate abilities 

according to specifications. 
(Screenshots of progress 

recommended or extra 

images have been 
completed to show mastery 

in skills). 

7 points: 

Only the required images 

are completed without 

screenshots or extra images 
to demonstrate a mastery of 

skills according to specs. 

4 points: 

Image is turned in.  

 

Effort Level 10 points: 

Images are created as 

shown in the tutorials. 
Images look aesthetically 

appealing and 

professionally done.  

7 points: 

Tutorial instructions have 

been followed. Images are 
not as clean and 

professional as they could 

be. Improvements could be 
made. 

4 points: 

Tutorial 

instructions were 
not followed 

completely. 

 

Requirements 

Completed 

5 points: 

Files are properly saved in multiple 
formats as shown in the tutorials. 

2 points: 

Files are saved only as one format or 
saved incorrectly. 

 

Total Points Earned  

(25 points possible) 
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Photoshop Project 5 S.E.T. 
 

cenario: Photoshop can also edit video. I don’t just mean it can create video files and 

play sample video in the 
background, but you can add 

effects, styles, and other layer tricks to 
video layers! Way Cool! 
 

xpectation: Make a lower thirds 
banner with logo for video.  
 

imeline: It may take 5-6 hours of class 
time for students to complete this 
project. 

 
 

Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress Learning, Activity, Timestamp, Experience.) 

Day 1 Date: Day 2 Date: 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 
 
 

 
 

 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 

 
 
 
 

 
 
 
 
 

 

 

S 

E 

T 
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Make sure to finish your BrainBuffet P.L.A.T.E. for every day you’re working on a tutorial! 
(Progress, Learning, Activity, Timestamp, Experience.) 

Day 3 Date: Day 4 Date: 

 
Videos Completed: _______________________ 

 

Screenshots to document progress?    

 

What was the coolest thing you learned? 
 
 
 
 
 

 
Videos Completed: _______________________ 

 

Screenshots to document progress?    

 

What was the coolest thing you learned? 
 

Day 5 Date: Day 6 Date: 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
 

Videos Completed: _______________________ 
 

Screenshots to document progress?    

 
What was the coolest thing you learned? 
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Photoshop Project 5 Worksheets 

Concise Help, Explanation, and Tips (CHEaTs) 

● Understand how to organize groups and layers. Make sure you recognize when it is 
locked! 

● Be careful not to rasterize your vector images or smart objects!  
● Always save your work! Some computers may run slower while importing your video. 

Be patient and SAVE, SAVE, SAVE! 

 

NOTES: Using the BrainBuffet Project 5 tutorials, please answer the following questions. 

 
1. For digital displays, resolution normally means the ___________________________________ 

(4k, 1080p, UHD, etc.). For print, the resolution is  ___________________________________

__________________________________________________________________  (300ppi). (5.01) 

2. Typical resolution for web & video is _____________________. _________________________  

________________________________________will determine the image resolution. (5.01) 

3. When making a Web Document make it ___________________, ___________________for 

best download speeds. (5.01) ____________________________________________________

_________________________________________________________________________________ 

4. When in doubt design  __________________________________________________________ . 

 ____________________________________________ image size gives better quality than 

_____________________________________________. (5.01) 

5. What program is the best option to make a professional Lower Thirds design? (5.02)  

_________________________________________________________________________________ 

6. Hold ______________________________________ to resize from the middle and constrain 

the shape when resizing to prevent distorting. (5.02) 

7. When placing a linked object, you can’t make any changes unless you 

______________________________________. (5.05) 
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8. Pro tip: Don’t give the client ____________________________________________________. 

Too many options ___________________________________________. Pick your favorite 

______________________________________ maximum and customize as requested. 

9. Save color you might need to reuse as _____________________________________________ 

that you can customize and re-use later. (5.05) 

10. What letter on the keyboard resets the foreground and background to Default 

colors? (5.05)  ___________________________________________________________________ 

What letter switches the colors? __________________________________ 

11. How do you lock the position of layers in a group? (5.07) __________________________

_________________________________________________________________________________ 

12. Locking just the position allows you to ____________________________________________

_________________________________________________________________________________

___________________________________________________________________________ (5.07) 

13. Chisel & hard settings look ______________________________________________________ .  

Soft and smooth setting tend to feel  ______________________________________ . (5.07) 

14. Use  ______________________________________________________________  in style settings 

 to be sure the shadows are unified. (5.07) 

15. If you wanted to add a stroke or drop shadow to a layer, what do you add? (5.07) 

___________________________________________________________________________________ 

16. How do you copy a layer style from one layer to another? (5.08)  __________________

_________________________________________________________________________________ 

17. How do you save a layer style? (5.08) _____________________________________________

_________________________________________________________________________________  
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18. How do you save a pattern? (5.09) _______________________________________________

_________________________________________________________________________________ 

19. How do you reduce the size of an image? (5.09) __________________________________

_________________________________________________________________________________ 

20. Define Resampling: (5.10) ________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

21. Define Cropping: (5.10) __________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 

22. Pro tip: when resampling, try to multiply by _________________________________ . (5.10) 

23. How do you save a Group as a file? (5.11) ________________________________________

_________________________________________________________________________________

_________________________________________________________________________________ 
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Photoshop Project 5 Checklist 
 

SPECIFICATIONS 

Lower Third PSD 
 

Lower Third Group 

 Title Text Group: 

o Type Layer “Astatula, Florida” with 
Bevel & Emboss, Stroke, & Drop 
Shadow layer styles 

o Type layer “Mike Jones” with Bevel & 
Emboss, Stroke, Pattern Overlay, & 
Drop Shadow layer styles 

 Lower Third BG Group: 
o BB-Logo-Perfect (smart object); 

locked position with Bevel & Emboss, 
Stroke, Color Overlay, & Drop Shadow 
layer styles 

o Polygon 1 vector [gear shape]; locked 
position with Bevel & Emboss, Stroke, & 

Drop Shadow layer styles 
o Rounded Rectangle 1 copy vector – 

locked position 
o Rounded Rectangle 1 vector – locked 

position 

 Black & white adjustment layer 

 Imported video layer with Smart Filter applied 

 Black background layer 

Completed folder should have: 

 Lower Third PSD file 

 Lower Third PNG file 

 “Mike Jones” PNG file 

 Video MP4 file 

 Background JPG file 

 Logo AI file 

 

Student should be able to: 

 

 Modify gradients by adding/removing color 
stops 

 Save color swatch 

 Save a pattern 

 Lock Layers within a group 

 Move layers from one group into another 

 Resample an image to a smaller resolution 
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Photoshop Project 5 Rubric 

 
 

Extension Challenges: 

● Complete BrainBuffet Photoshop CC15 Project 7 - Bottom Thirds 

● Take a video of your friends announcing something for your class or club. Make a 

lower third with your school, class, or club logo and import your own video. 

● Adobe Education Exchange tutorials on Lower Thirds 

Cross-Curricular Enrichment: 

● Language Arts: Write an article about an event that you’ve recently attended. Why 
were you at the event? What did you learn or do while in attendance? 

● Math- Try to figure out what resolution a film needs to be for a movie theater screen. 

● Social Studies- Nowadays, technology has given the ability for everyone to be a 
journalist. Think of a historic event that happened before we were able to document 

every moment of our lives. Write a brief reflection on how you think modern 
technology would have impacted that event?  

● Science/Technology- Make a stop motion animation! It’s fun – try it! 

PHOTOSHOP PROJECT 5 SCORING RUBRIC Student 

Score 

Mastery of 

Skills 

10 points: 

Student is able to demonstrate 

abilities according to 
specifications. (Screenshots of 

progress recommended or 

extra images have been 
completed to show mastery in 

skills). 

7 points: 

Only the required images 

are completed without 
screenshots or extra images 

to demonstrate a mastery of 

skills according to specs. 

4 points: 

Image is 

turned in.  

 

Effort Level 10 points: 

Image and video are created 

as shown in the tutorials. Layers 

styles enhance the overall look 
of the design and the lower 

third banner looks professional. 

7 points: 

Tutorial instructions have 

been followed. Layer styles 

are distracting and lower 
third banner does not look 

clean. 

4 points: 

Tutorial 

instructions 

were not 
followed 

completely. 

 

Requirements 

Completed 

5 points: 

Files are properly saved in multiple 
formats as shown in the tutorials. 

2 points: 

Files are saved only as one format 
or saved incorrectly. 

 

Total Points Earned  

(25 points possible) 

 



 
 
Name: ________________________________________________________   Date: _____________ Period: _________ 

 

ACATP ON GMETRIX | PHOTOSHOP CC18|19|20 | GAMER MISSION HANDBOOK 
 

                                                                      Freely use and copy this unmodified workbook with this footer intact.  

 Page 53 

Photoshop Project 6 Worksheets 

 

NOTES: Using the BrainBuffet Project 6 tutorials, please answer the following questions. 

 
1. What are the two most important concerns when thinking about designing? ____________ 

______________________________________________________________________________________ 

2. What are demographics? ____________________________________________________________ 

______________________________________________________________________________________  

3. What are the six major steps to a project plan? ________________________________________ 

______________________________________________________________________________________ 

4. How are scope and deadlines often communicated in a design project? 

______________________________________________________________________________________ 

5. What is project creep? _______________________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________ 

6. Negative space is sometimes referred to as ___________________________________________. 

7. What are Photoshop’s primary colors? _________________________________________________ 

8. ___________________________________ are alongside each other. ________________________ 

____________________ create contrast. 

9. __________________________ are “nouns”. ____________________________ are “Verbs”. 

10. What are the six principles of design? _________________________________________________ 

______________________________________________________________________________________ 

______________________________________________________________________________________  
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Using the boxes below, draw an example of each elements of art. 
                

 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 

 
 
 
 
 

 
 
 
 
  

shape line 

type form 

texture space 

color value 
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Extension Challenges: 

● Adobe Education Exchange, especially What is a Photoshop Project Plan, “Principles 

of Design” Animation, and Elements of Art & Principles of Design Grid Project.  

● Elements of Art poster: https://edex.adobe.com/resource/v97893453 

● Find a client (ideas for client below) and offer to design a poster or bulletin for them. 

Keep the design process In mind and create something for them. (Possible potential 

clients: schoolteacher, school club, school sports team, student government. 

community sports team, community center, small business/shop, etc). 

Cross-Curricular Enrichment: 

• Language Arts: Think of your favorite book and why that is your favorite. Using the 

elements & principles of design create a design or draw something that conveys that 

feeling. See if your design evokes that emotion from others. 

• Math: Partner up with another student. Each student should take turns being the client 

and then the design. As the client, students need to come up with a company, the 

company’s target audience, and what they sell. Create a logo geometric design. As 

the designer, students need to come up with a geometric logo for the client that suits 

their needs. 

• History: Pick a time period and make an advertisement for an event that could have 

happened in that time period. The event does not have to be a real event but it does 

have to be a believable event for that time period.  

• Geography: Pick another worldly destination and do some research on the culture of 

the people that live there. What are the differences and similarities between where 

you live and the place you chose? Write a paragraph on your findings and create two 

ads for the SAME company. One based on the demographics of where you live and 

one based on the demographics of the country you researched.  
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Photoshop CC18|19|20 CHEAT Sheets 
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Keyboard CHEAT Sheet 
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